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Abstract

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office Release 9.0 and the Avaya Session
Border Controller for Enterprise to interoperate with TW Telecom Managed SIP Services.

TW Telecom Managed SIP Services provides PSTN access via a SIP trunk between the
enterprise and the TW Telecom network as an alternative to legacy analog or digital trunks.
This approach generally results in lower cost for the enterprise. TW Telecom is a member of
the Avaya DevConnect Service Provider program.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office Release 9.0 and the Avaya Session
Border Controller for Enterprise (Avaya SBCE) to interoperate with TW Telecom Managed SIP
Services.

TW Telecom Managed SIP Services referenced within these Application Notes is positioned for
customers that have an IP-PBX or IP-based network equipment with SIP functionality, but need
a form of IP transport and local services to complete their solution.

TW Telecom Managed SIP Services will enable delivery of origination and termination of local,
long-distance and toll-free traffic across a single broadband connection. A SIP signaling
interface will be enabled to the Customer Premises Equipment (CPE).

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site via the public Internet and
exercise the features and functionality listed in Section 2.1. The simulated enterprise site was
comprised of Avaya IP Office and various Avaya endpoints listed in Section 4.

TW Telecom Managed SIP Services passed compliance testing with any observations or
limitations described in Section 2.2.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

e Sending/receiving SIP OPTIONS queries to/from the service provider

e Incoming PSTN calls (via the TW Telecom SIP trunk) to SIP and H.323 telephones at the
enterprise

e QOutgoing PSTN calls (via the TW Telecom SIP trunk) from SIP and H.323 telephones at
the enterprise

e Inbound and outbound PSTN calls to/from soft clients (Avaya IP Office Video Softphone
and Avaya Flare® Experience for Windows)

e Various call types including: local (10 digits), long distance (1 + 10 digits), outbound
toll-free, international (011 + country code + number), operator, operator-assisted (0 + 10
digits) and local directory assistance (411)
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Codec G.711MU

Caller ID presentation and Caller ID restriction

DTMF transmission using RFC 2833

Response to incomplete call attempts and trunk errors

Voicemail navigation using DTMF input for inbound and outbound calls
Voicemail message waiting indicator (MWI1)

User features such as hold and resume, internal call forwarding, transfer, and conference
Off-net call forwarding and twinning

G.711 fax

Direct media for connecting media from the Avaya SBCE directly to the internal
enterprise endpoint and bypassing Avaya IP Office where possible.

Remote worker

Emergency calls (911) and inbound toll-free calls are supported but were not tested as part of
the compliance test.

The following items are not supported:

G.729 codec
T.38
REFER message for call redirection

2.2. Test Results

Interoperability testing of TW Telecom Managed SIP Services was completed with successful
results for all test cases with the exception of the observations/limitations described below.

Call Forwarding and EC500: For inbound PSTN calls that were forwarded back to the
PSTN or ring to an EC500 (enterprise mobility) PSTN endpoint, the PSTN destination
phone display (if equipped) showed the TW Telecom trunk group pilot number instead of
the original PSTN caller. This should be corrected in a future release of the BroadSoft
platform used by TW Telecom.

2.3. Support

For technical support on TW Telecom Managed SIP Services, please contact TW Telecom via
the following:

Web: http://www.twtelecom.com

Phone: 1-800-829-0420
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http://www.twtelecom.com/

3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to TW Telecom Managed SIP Services.

Located at the enterprise is the Avaya SBCE. It has a public side that connects to the TW
Telecom enterprise SBC (Genband Qflex ESBC). This forms the demarcation point of the TW
Telecom Managed SIP Service. The private side of the Avaya SBCE connects to the enterprise
network. All SIP and RTP traffic entering or leaving the enterprise flows through the Avaya
SBCE. In this way, the Avaya SBCE can protect the enterprise against any SIP-based attacks.
The Avaya SBCE provides network address translation at both the IP and SIP layers.

The enterprise site contains an Avaya IP Office 500 V2 with various endpoints and a Windows
2003 Server running both Avaya IP Office Manager to configure the Avaya IP Office and Avaya
VoiceMail Pro for voicemail.

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 4 of 60
SPOC 9/23/2014 ©2014 Avaya Inc. All Rights Reserved. TWTIPO9SBCE



Remote Worker TW Telecom

Avaya Flare®
Experience for TW Telecom
“"(';‘I’g;”s Managed SIP

Services
& ~—

Intern
TW Telecom Managed SIP
. . Services Demarcation
Enterprlse Site Point at the Enterprise
[ Genband Qflex / \
FVX50 ESBC
Avaya IP Offico A 192.168.100.54 o
Manager : e vaya Flare®®
Avaya nggffioe SIP : 192:168.96.233 Experience for
Voicemalil Pro RILY. Avaya Session Border Controller Windows
IS for Enterprise -
10.32.128.20
SIP |
RTP |
—_— T Enterprise LAN p——
T T T
|
lg v 10.32.128.25 9
Avaya 1100/1200 Avaya 1600 Series
Series IP Avaya IP Office 500 V2 | |p peskphone(s) Avaya IP Office
Deskphone(s) (H.323) Video Softphone
(SIP) (SIP)
Domain: avaya.com ﬂ
DID Numbers: Fax
720 555-1234 Avaya 9600 Series
720 555-1235 IP Deskphone(s)
720 555-1236 (H.323)
720 555-1237
\_ 720 555-1238 /
Figure 1: Avaya Interoperability Test Lab Configuration
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For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have been replaced with numbers

that cannot be routed over the PSTN.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to send digits
across the SIP trunk to TW Telecom. The short code of 9 is stripped off by Avaya IP Office and
the remaining digits were sent unaltered to TW Telecom. TW Telecom requires 11 digits (1+10
digits) be sent in the Request URI header for long distance calls and 10 digits for local calls. On
inbound calls, TW Telecom will send 10 digits in the Request-URI.

4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Software

Avaya IP Office 500 v2

9.0 SP3 (941)

Avaya IP Office Manager

9.0 SP3 (941)

Avaya IP Office VoiceMail Pro

9.0 SP3 (212)

Avaya Session Border Controller for
Enterprise running on a Portwell CAD-0208
server

6.2.1.Q07

Avaya 1140E IP Deskphone (SIP)

4.4 SP1 (04.04.14)

Avaya 1608 IP Deskphone (H.323) running
Avaya one-X® Deskphone Value Edition

1.3.5 (1.350B)

Avaya 9641G IP Deskphone (H.323) running
Avaya one-X® Deskphone Edition

6.3.1 (6.3116)

Avaya IP Office Video Softphone (SIP)

3.2.3.49 (68975)

Avaya Flare® Experience for Windows 1.1.4.23
TW Telecom Components
Equipment Software
Broadworks Application Servers IP PBX R16SP2
GenBand Qflex (FortisVox) FVX50 ESBC 5.6.2

Testing was performed with Avaya IP Office 500 V2, but this testing also applies to Avaya IP
Office Server Edition running the same software release. Note that Avaya IP Office Server
Edition requires an Expansion IP Office 500 V2 R9 to support analog or digital endpoints or

trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - Programs - IP Office - Manager to launch the
application. A screen that includes the following may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Oipen Configuration from System

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group Pane has been omitted, its content is shown as submenus in the Navigation
pane. These panes (Navigation, Group and Details) will be referenced throughout the Avaya IP
Office configuration. All licensing and feature configuration that is not directly related to the
interface with the service provider (such as twinning and IP Office Video Softphone support) is
assumed to already be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation
described in the following sections (e.g., License = SIP Trunk Channels) appears as submenus
underneath the system name Atlantic City in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) in the

Details pane.

IP Offices | e -8 X v <>
@R BOOTP (1) | License | Remote Server|
[#-¢# Operator (3)
=459 Atlantic City License Mode License Mormal
[H-%29 Systemn (1)
17 Line (17) PLDS HostID 111304907550
(-2 Control Unit (3]
[#-48 Extension (25) Feature License Key Instances Status o Add...
g% gse' (22] IP500 Voice Networking Channels 4 Valid -
roup N . lemove
8% Short Code (54) VM Channel Migration 255 Valid
..... @ Service (0) SIP Trunk Channels 255 Valid |
[+l RAS (1) VPN IP Extensions 255 Obsolete
D"'@ Incoming Call Route (41 IP500 Universal PRI (Additional cha... 255 Valid
""" @ 'E';'fAN pmém RAS LRQ Support (Rapid Response) 255 Valid
e Ti'::tgg'ffle) o IP Office Dealer Support - Standar... 255 Valid
EJ@ Firewall Profile (1) IP Office Dealer Support - Professi... 255 Valid
(-l IP Route (4) IP Office Distributor Support - Stan... 255 Valid
""" & Account Code (0) IP Office Distributer Support - Prof.., 255 Valid
""" ; UMS Web Services 255 Valid
----- unne "
B licar Binkhte (@ CCRSUP %5 Valid
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To view the physical hardware comprising Avaya IP Office, expand the components under the
Control Unit in the Navigation pane. In the sample configuration, the second component listed
is a Combination Card. This module has 6 digital stations ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module supporting
VoIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary

to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices | & -BIX <>
=- K BOOTP (1) Unit
4% Operator (3)
=3 Atlantic City Device Mumber 1
(-39 System (1) _
T]; Line (17) Unit Type IP 500 v2
=2 Control Unit (3)
I 1 1P 500 V2 Version 9.0.300.941
= 2 COMBO6210/ATM4 Serial Nurmb
‘-tz 3 DIGSTAS/ATMA Enal Mumber
-4 Extension (25) . 1032128.25
D"'i User 27) Unit IP Address
-8 Group (1) Interconnect Number 0
-8 Short Code (64)
""" B Service () Module Nurmber Control Unit
ol RAS (1)
-4 Incoming Call Route (41) || Operating Mode -
----- B2 WAN Port (0)
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5.2. System

Configure the necessary system settings.

5.2.1. System — LAN1 Tab

In the sample configuration, the Avaya IP Office LAN port was used to connect to the enterprise
network. The LANL1 settings correspond to the LAN port on the Avaya IP Office 500 V2. To
access the LANL1 settings, first navigate to System = <Name>, where <Name> is the system
name assigned to the Avaya IP Office. In the case of the compliance test, the system name is
Atlantic City. Next, navigate to the LAN1 - LAN Settings tab in the Details Pane. Set the IP
Address field to the IP address assigned to the Avaya IP Office LAN port. Set the IP Mask
field to the mask used on the enterprise network. All other parameters should be set according to

customer requirements.

IP Offices

X

Atlantic City

=& BOOTP (1)

(#+ Operator (3)

E|--->-3- Atlantic City

[]-557 System (1)
L2 Atlantic City
T Line (18)

(- Control Unit (3)

(-4 Extension (26)

E-§  User (27)

E1-59§ Group (1)

@M% Short Code (64)

-G8y Service (0)

F-alle RAS (1)

(P Incoming Call Route (41)
w WAN Port (0]

-1 Directory (0)

- Time Profile (0)

-8 Firewall Profile (1)

-Jill IP Route (4)

- Account Code (0)

SMDR | Twinning [ VCM | CCR | Codecs

ACCS |

System | LANL | LAN2 | DNS | Voicemai

Telephony | Directory Services | Systemn Events | SMTP |

LAN Settings |VoIP‘ | Network Topology|

Yy

Nurnber Of DHCP IP Addresses 200
DHCP Mode

) Server () Client

IP Address 10 32 128 25

IP Mask 255 255 255 0

Primary Trans. [P Address 0 0 0 0

RIP Mode lNone -
[7] Enable NAT

) Dialin @ Disabled
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On the VoIP tab in the Details Pane configure the following parameters:

e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

e The RTP Port Number Range can be customized to a specific range of receive ports for
the RTP media. Based on this setting, Avaya IP Office would request RTP media be sent
to a UDP port in the configurable range for calls using LANL1.

H—

Atlantic City

e

v < =

| System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | veM | CCR | Codecs | Accs |

LAN Settings | VeIP | Metwork Topologyl

H323 Gatekeeper Enable
[[] Auto-create Extn

SIP Trunks Enable

SIP Registrar Enable
[[] Auto-create Extn/User

Domain Name

Layer 4 Protocaol

Challenge Expiry Time (secs)

RTP
Port Number Range

Minimum 49152

Port Nurmber Range (NAT)
Minirum 49152

Auto-create User

[] H323 Remote Extn Enable

[] SIP Remote Extn Enable

m

upp UDP Port 5060
TCP TCP Port 5060
O] TS TLS Port 5061
10 =
= Maximum 53246
- Maximum 53246

4

3

Rermote UDP Port 5060
Remote TCP Port 5060

Remote TLS Port 5061
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Scroll down the page.

In the RTP Keepalives section, set the Scope to RTP. Set the periodic timeout to 30 and
the Initial Keepalives parameter to Enabled. These settings will cause Avaya IP Office
to send a RTP keepalive packet starting at the time of initial connection and every 30
seconds thereafter if no other RTP traffic is present. This facilitates the flow of media in
cases where each end of the connection is waiting to see media from the other, as well as
helping to keep firewall ports open for the duration of the call.

In the DiffServ Settings section, Avaya IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient,
appropriate values will be provided by the customer.

All other parameters should be set according to customer requirements.

Atlantic City i v | <

| system | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | veM | CCR | Codecs | Accs |

LAN Settings | VolIP |NetworkTopology|

Enable RTCP Menitering on Port 5005

Keepalives
Scope ’RTP v] Periodic timeout 30
Initial keepalives ’Enabled v]

DiffServ Settings

B8 +| DSCP{Hex) B8 +| Video DSCP{Hex) |FC +| DSCP Mask (Hex) |88 +| SIG DSCP (Hex)
46 +| Dscp 46 1| Video DSCP 63 1| DSCP Mask 34 1| SIGDSCP
DHCP Settings

Primary Site Specific Option Number (550M) 176 =

Secondary Site Specific Option Number (SS0M) 242 =

VLAN

1100 Voice VLAM 5ite Specific Option Mumber (S50N) 232 =

1100 Voice VLAM IDs

Mot Present -

m
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. Since no firewall or network address translation (NAT) device was used
between the Avaya IP Office and the Avaya SBCE, the parameter was set to Open
Internet.

e Set Binding Refresh Time (seconds) to 30. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider.

e Inthe Public Port section, next to the transport protocol UDP, select the UDP port on
which Avaya IP Office will listen.

e All other parameters should be set according to customer requirements.

[l

1= Atlantic City ) v|<|>

VCM | CCR | Codecs | ACCS |
System | LAMNL ‘ LANZ | DMS | Yeicemail |Te|ephony| Directory Services | System Events | SMTP | SMDR | Twinning |

LAN Settings | VelP | Network Topology |
Metwork Topology Discovery
STUN Server Address 10.80.168.12 STUM Port 3478 =
Firewall/NAT Type Open Internet -
Binding Refresh Time (seconds) 30 =
Public IP Address 0 0 0 0 Cancel
Public Port
UDp 5060 =
TCP 0 =
TLS 0 S
[] Run STUN on startup
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5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony = Telephony tab in the
Details Pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding
and call transfer to the PSTN. If for security reasons incoming calls should not be allowed to
transfer back to the PSTN then leave this setting checked.

e v <>

| System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | vem | cCR | Codees | Accs |

= Atlantic City

Telephony | Park &Pagel Tones & Musicl Ring Tones | 5M | Call Log | TUI |
Analogue Extensions
Default Qutside Call Sequence lNormaI VI
Default Inside Call Sequence ’Ring Typel VI
Default Ring Back Sequence [Ring Typel VI
Restrict Analegue Extension Ringer Voltage [

Dial Delay Time (secs) 4 =

Dial Delay Count 0 =

Default Mo Answer Time (secs) 25 =

Hold Timeout (secs) 0 =

Park Timeout (secs) 300 =

Ring Delay (secs) 3 =

Call Priority Promotion Time (secs) |Disabled =

Default Currency usb hd

Default Mame Priority

Media Connection Preservation lD‘isabIed V]

»

Companding Law —

Switch Line
@ U-Law @ U-Law Line
) A-Law ) A-Law Line

[] Dss Status

Auto Hold

m

Dial By Mame
Show Account Code
[] Inhibit Off-Switch Forward/Transfer
[ Restrict Metwork Intercennect
[T] Drop External Only Impromptu Conference
[T Visually Differentiate External Call
[] Unsupervised Analog Trunk Disconnect Handling
High Quality Conferencing

[ Strict SIPS
Digital/Analogue Auto Create User
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5.2.3. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details
Pane as shown in the following screen. The Send original calling party information for
Mobile Twinning box is not checked in the sample configuration, and the Calling party
information for Mobile Twinning is left blank. Click the OK button at the bottom of the page
(not shown).

[l

= Atlantic City

System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events [ SMTP | SMDR | Twinning @

[] Send original calling party information for Mobile Twinning

Calling party information for
Mobile Twinning

5.3. IP Route

A default route is needed so IP Office can reach other network subnets other than the one where
it resides. Since IP Office and the private side of the Avaya SBCE reside on the same subnet, the
default route is not specifically used for SIP Trunking. Navigate to IP Route = 0.0.0.0 in the
left Navigation Pane if a default route already exists. Otherwise, to create the default route,
right-click on IP Route and select New. Create/verify a default route with the following
parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the default router on the network where
Avaya IP Office is connected.

e Set Destination to LAN1 from the drop-down list.

Click the OK button at the bottom of the page (not shown).

IP Offices |

=- R BOOTP (1) IP Route
-4 QOperator (3)
- Atlantic City IP Address o 0 .0 .0

0.0.0.0 - X vl

i

H-%2) Systemn (1)
H-T4 Line (18)

-+ Control Unit (3) Gateway IP Address 10 . 32 . 128 . 254

E IP Mask 0 0 1] a
[

[+ Extension (26)

[

[

[

i-§  User (27) Destination [LAN]_ -
]ﬁ Group (1)
Jg Short Code (64) Metric 0 =
""" Service (0)
ol RAS (1) [] Proxy ARP
- Incoming Call Route (41)
----- B8 WAN Port (0)

""" @ Directory (0)

----- 1% Time Profile (0)

G-} Firewall Profile (1)

13
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and TW Telecom
Managed SIP Services. The recommended method for configuring a SIP Line is to use the
template associated with these Application Notes. The template is an .xml file that can be used
by IP Office Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP
Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.2 — 5.4.5.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

To create a SIP Line manually, right-click Line in the Navigation Pane and select New - SIP
Line; then, follow the steps outlined in Sections 5.4.2 —5.4.5.
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5.4.1. SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to US_TWTelecom_SIPTrunk.xml. The file name is important in locating
the proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Verify that the box is checked next to Enable
Template Options. Click OK.

" IP Office Manager Preferences &léj

| Preferences | Directories | Discovery | Visual Preferences | Security | 1l.n"aliu::iatiu:rr1|

Icon Size ISmaII v]
Multiline Tabs
Enable Template Options

i) ‘ OK ‘ | Cancel | ‘ Help

e

3. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager. This action will copy the template file into the IP
Office template directory and make the template available in the IP Office Manager pull-
down menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

' Avaya IP Office Manager Atlantic Gty |
File  Edit View Tn:n:nlslHeIp

2 =E-H EE Extension Renumber... ’
Line Renumber... |
IP Office:
Connect To... ||
=R BOOTP (1) Export .l

#-i# Operator (3)
=% Atlantic City S5CM Service User Management

[H--5%0 System (1)

T_‘f Line (17) Busy on Held Validation

- Control Unif MSM Configuration

-4 Extension (2 _

a User (27) Print Button Labels

ﬁ Group (1) Irport Templates in Manager

-8 Short Code (g e
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5.

In the pop-up window (not shown) that appears, select the directory where the template
file was copied in Step 1. After the import is complete, a final import status pop-up
window (not shown) will appear stating success or failure. Click OK (not shown) to
continue. If preferred, this step may be skipped if the template file is copied directly to
the IP Office template directory.

To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
then navigate to New - New SIP Trunk From Template.

IP Offices = SIP Line
- R BOOTP (1) SIP Line Transport| SIP URI|VolP | T38 Fax|SIP Credentials
4% Operator (3]
-39 AtlantisCie 2 =
-y E” ] New v | H33Line
gT ' Co ﬂ Generate SIP Trunk Template IP DECT Line
. SIP L
-4 Ext T Ctrl+X ne
[3...& Use 3 C e C 5M Line
A= opy s
-5 Gr SIP DECT Line
[+ 8% Shg Paste Ctrl+V
..... @ Ser % Delete e Mew SIP Trunk From Template
g RA
El"'@ Inc| » Validate
""" Eﬂ WA Connect To... Ctrl+T
""" ;t: 'I[Eilr: Mew from Template (Binary) o
[]@ Fire Export as Template (Binary) lDiversion Header
=il 1P Route (4] i [

In the subsequent Template Type Selection pop-up window, select United States from
the Country pull-down menu and select TWTelecom from the Service Provider pull-
down menu as shown below. These values correspond to parts of the file name
(US_TWTelecom_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to
finish creating the trunk.

" Template Type Selection l = i&,l
b ol PR——
Locale United States (US English)
Courtry [Un'rted States v]
Service Provider [TWTeIecnm v] [ Display &l
’ Create new SIP Trunk ] [ Cancel ]

6. Once the SIP Line is created, verify the configuration of the SIP Line with the

configuration shown in Sections 5.4.2 — 5.4.5.
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5.4.2. SIP Line — SIP Line Tab
On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

e Set ITSP Domain Name to the IP address of the private interface of the Avaya SBCE.

e Set Send Caller ID to Diversion Header. With this setting and the related configuration
in Section 5.2.3, Avaya IP Office will include the Diversion Header for calls that are
directed via Mobile Twinning out the SIP Line to TW Telecom. It will also include the
Diversion Header for calls that are call forwarded out the SIP Line.

e TW Telecom does not supports REFER. Thus, REFER Support should be unchecked.

e Check the In Service box. This makes the trunk available to incoming and outgoing
calls.

e Check the Check OOS box. Avaya IP Office will use the SIP OPTIONS method to
periodically check the SIP Line. The time between SIP OPTIONS sent by Avaya IP
Office will use the Binding Refresh Time for LAN1, as shown in Section 5.2.1.

e Default values may be used for all other parameters.

IP Offices 8IP Line - Line 26 g -8 X v ]<]>

& BOOTP () SIP Line Transport | siP URI|VolP  [T38 Fax|SIP Credentials
¢ Operator (3)
=+ Atlantic City Line Number 25 =
-5 Systern (1)

-9 Line (18) ITSP Domain Mame 10.32128.20 In Service
= Control Unit (3]
-4 Extension (26) URI Type [SIP v]
-@ User(27)
5@ Group (1) Prefix Check 005
-BX Short Code (64)
@ Service (0) Matienal Prefix 1] Call Routing Method [Reque;t URI V]
Ba; RAS (1)
@ Incoming Call Route (41) Country Code
- §E WAN Port (0}

P e W e e W e W

Originater number for
forwarded and twinning calls

I

- Directory (0) International Prefix 00 Mame Priority [System Default ']
~£7 Time Profile (0)
[ @ Firewall Profile (1) Send CallerID [Dwersion Header '] Caller ID from From header =
-l IP Route (4)
- Account Code (0) Association Method [By Source [P address V] Send From In Clear [}
Q; License (77) User-Agent and Server
il Tunnel {0) Headers
[E: ﬁ 3 User Rights (8)
B¢ ARS (5) Service Busy Response [486 - Busy Here ']
- RAS Location Request (0) . .
-4 Location (0) Action on CAC Lecation Limit [AIIooni(ema\I v]

[T REFER Support

Auto
Auto
Method for Session Refresh [Auto v]
Session Timer (seconds) On Demand =
Media Connection Preservation [System ']
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5.4.3. SIP Line - Transport Tab

Select the Transport tab. Set or verify the parameters as shown below.

e Set ITSP Proxy Address to the IP address of the internal signaling interface of the

Avaya SBCE.
e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to the network port used by the SIP line to access the

far-end and configured in Section 5.2.1.
e Set the Send Port to 5060.

e Default values may be used for all other parameters.

= SIP Line - Line 25

ek -@ X[ v <>

SIP Line Transport |SIP URI|VolP | T38 Fax|SIP Credentials

ITSP Proxy Address  10.32.128.20

Metwork Configuration

Layer 4 Protocol [UDP

Use Metwork Topology Info [LAN 1

Explicit DMS Server(s) ] a ] ]

Calls Route via Registrar

Separate Registrar

Send Port

5060

5060
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5.4.4. SIP Line - SIP URI Tab

A SIP URI entry must be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at
the top, and click the Edit button. In the example screen below, a new entry is created. The
entry was created with the parameters shown below:

Set Local URI, Contact, and Display Name to Use Internal Data. This setting allows
calls on this line that have a SIP URI that matches the number set in the SIP tab of any
user as shown in Section 5.7.

Set PAI to None.

Set Registration to 0: <None>.

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line in Section 5.8.1. Similarly, associate the line to an outgoing line
group using the Outgoing Group field. The outgoing line group number is used in
defining ARS entries for routing outbound traffic to this line in Section 5.6. For the
compliance test, a new incoming and outgoing group 25 was defined that only contained
this line (line 25).

Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Click OK.
= SIP Line - Line 25 ef - X v <>
SIP Line|Transport SIP URI |VolP | T38 Fax|SIP Credentials
Channel Groups Via Local URT Contact Display Name PAI Credential Max Calls Add...
Remove

Edit...

Mew Channel

oK
Via 10.32.128.25

Cancel

Local URI Use Internal Data v
Contact Use Internal Data -
Display Marme Use Internal Data -
PAI Mone v
Registraticn 0: <Monex -
Incoming Group 25
Outgoing Group 25
Max Calls per Channel 10 -
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Additional SIP URIs may be required to allow inbound calls to numbers not associated with a
user, such as a short code. These URIs are created in the same manner as shown above with the

exception that the incoming DID number is entered directly in the Local URI, Contact, and
Display Name fields.
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5.45. SIP Line - VoIP Tab

Select the VoI P tab, to set the Voice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below.

For Codec Selection, select System Default from the pull-down menu to use the default
list of codecs. A list of the codecs in their current order of preference will be shown on
the right in the Selected column. To use a custom list of codecs, select Custom for
Codec Selection. Next, move unwanted codecs from the Selected column to the Unused
column. Lastly, move the codecs up or down the list in the Selected column to achieve
the desired order of preference. The example below shows the codecs used for the
compliance test. The list must include G.711 ULAW which is the codec supported by
TW Telecom.

Uncheck the VolP Silence Suppression.

Testing was performed with and without Direct Media enabled. If the customer wishes to
use Direct Media, then check the Allow Direct Media Path and Force direct media
with phone boxes. If not, leave the boxes unchecked as shown below.

Check the Re-invite Supported box.

Set the Fax Transport Support to G.711.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Default values may be used for all other parameters.

Click the OK button at the bottom of the page (not shown).

o
i
=

SIP Line - Line 25 Bk - X v«

|SIP Line| Transport | SIP URI VoIP T3 Fax|SIP Credentials

Codec Selection ISystem Default 'J Re-invite Supported
[} Codec Lockdown
. G.711 ULAW 64K
G.711 ALAW 64K [7] PRACK/100rel Supported
G.729(a) 8K C5-ACELP
5.723.1 6K3 MP-MLQ Force direct media with phones

Fax Transport Support IG.?ll vJ
Location ICIoud vJ
Call Initiation Timeout (s) 4 =

DTMF Support [RFC2833 ~|

[] VolIP Silence Suppression

[7] Allow Direct Media Path

[[] G.711 Fax ECAN

ol

-
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5.5. Short Codes

ARS is used to route outbound traffic to the SIP line. A short code is used to route outbound
traffic to ARS. To create a short code, right-click on Short Code in the Navigation Pane and
select New. On the Short Code tab in the Details Pane, configure the parameters as shown
below.

¢ Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.

e Setthe Line Group Id to the ARS route to be used which is defined in Section 5.6.

Click the OK button (not shown).

IP Offices E 9N;: Dial -8 X[ v <>

&K BOOTP (1) Shert Code
(-7 Operator (3)
E1-3 Atlantic City Code g

[H-559 System (1)

E-T7 Line (17) Feature [Dial i

[#-=¢ Control Unit (3]

(-4 Extension (25) Telephone Number M

E-§  User (27) . : -

[]---ﬂ Group (1) Line Group ID 54: TW Telecom

81 Short Code (64) Locale ’ -

- Service (0)

[H-adf; RAS (1) Force Account Code  []
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”.

In the case of the SIP Line to TW Telecom documented in these Application Notes, when a user
dials *67 plus the number, Avaya IP Office will include the calling number in the P-Preferred-1D
(PP1) header and will include the Privacy: Id header.

K

= *67N;: Dial il | vl <|>
Short Code

Code *BTM:

Feature Dial -

Telephone Number  WH

Line Group ID 54: TW Telecom -

Locale ’ -

Force Account Code [
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5.6. ARS

ARS is used to route outbound traffic to the SIP line. To define a new ARS route, right-click
ARS in the Navigation pane and select New. In the Details pane that appears, a collection of
matching patterns (similar to short codes) can be entered to route calls as shown below.

For the compliance test, one entry was created. The entry matches on any number N and then
sends that number (N) in the SIP INVITE message on the line group defined in Section 5.4.4
(e.g., line group 25).

To create an entry, click the Add button and enter the following in the pop-up window (not
shown).
e Inthe Code field, enter the pattern to match the number passed to ARS from the short
code in Section 5.5 followed by a semi-colon.
e Set Feature to Dial. This is the action that the entry will perform.
e Set Telephone Number to N”@10.32.128.20”. This field is used to construct the
Request URI and To headers in the outgoing SIP INVITE message. The value N
represents the complete number passed to ARS. The domain 10.32.128.20 is the IP
address of the Avaya SBCE.
e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.4.4. This short code will use this line group when placing the
outbound call.

Click the OK button (not shown).

IP Offices

TW Telecom

ef @ X vl<]>

+x

BOOQTP (1)

-4 Operator (3)

=)= Atlantic City
+ -*30 System (1)
f ~F9 Line (18)
% <2 Control Unit (3)
# - Extension (26)
#-§  User(27)
#-5f Group (1)
-8 Short Code (64)
4B Service (0)
-df; RAS (1)
3 e Incoming Call Route (41)
L) WAN Port (0)
-8 Directory (0]
-0 Time Profile (0)
- Firewall Profile (1)
+-Jill IP Route (4)
- Account Code (0)
- License (77)
W& Tunnel (0}

# -4 User Rights (8)

o IS

i~ RAS Location Request (0)
i Location (0)

ARS

ARS RouteId

Route Mame

Dial Delay Time

In Service

Time Profile

54

TW Telecom

Systern Default (4)

V|

l

<Mones>

l

Secondary Dial tone

SystemTene

Check User Call Barring

Out of Service Route

e Quit of Hours Route

|<None>

|<None>

Code

Telephene Mumber
N"@10.32.128.20"

Feature
Dial

Line Group ID
25

Remove

Edit...
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first navigate to User = Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is Extn243. Select the SIP tab in the Details Pane. The values entered for the
SIP Name and Contact fields are used as the user part of the SIP URI in the From and Contact
headers for outgoing SIP trunk calls and allow matching of the SIP URI for incoming calls
without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4.4). The
example below shows the settings for user Extn243. The SIP Name and Contact are set to one
of the DID numbers assigned to the enterprise from TW Telecom. The SIP Display Name
(Alias) parameter can optionally be configured with a descriptive name. If all calls involving
this user and a SIP Line should be considered private, then the Anonymous box may be checked
to withhold the user’s information from the network.

Click the OK button (not shown).

IP Offices i Extn243: 243 ef - X[ v <>
:a E]OOTE (133) User |V0icemai| | DD | Short Codes | Source Mumbers | Telephony | Forwarding | Dial In | Voice Recording |
{7 Operator
i...:..“‘_ Aigantic City Button Programming | Menu Programming | Mobility | Group Membership | Announcementsl SIP | Personal Directory|
+-%59 System (1)
17 Line (17) SIP Name 7205551235
+-<= Control Unit (3) . . Extn243
+¢9 Extension (25) SIP Display Mame (Alias) n
e8] Contact 7205551235
+ﬂ Group (1)
+“ Short Code (54)
@ Service (0) [T] Anonymous
5l RAS (1)
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To
create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and

select New.

5.8.1. Incoming Call Route — Standard Tab

On the Standard tab of the Details Pane, enter the parameters as shown below.

e Set the Bearer Capacity to Any Voice.

e Setthe Line Group Id to the incoming line group of the SIP line defined in Section
5.4.4.
e Set the Incoming Number to the incoming number on which this route should match.

e Default values can be used for all other fields.

i

257205551235

[Any Voice

7205551235

[1 - Low

[System Source

IP Offices =
@R BOOTP (1) Standard | Voice Recording | Destinations|
i Operator (3)
-3 Atlantic City
Dmh“‘_' System (1] Bearer Capability
F-F4 Line (18)
[#-=» Control Unit (3] Line Grnup I 25
[+ Extension (26)
E-§  User 27) Incoming Number
-5 Group (1)
8% Short Code (54) Inceming Sub Address
D"'E ;irgla? @ Incoming CLI
E]—--@ Incoming Call Route (44| | . [
----- B2 WAN Port (0)
----- @2 Directory (0] Pririty
----- £1% Time Profile (0)
E]—--@ Firewall Profile (1) Tag
G-l IP Route (4)
..... #m Account Code (0) Hold Music Source
----- & License (77) . .
_____ @& Tunnel (0) Ring Tone Override

Mone

5.8.2. Incoming Call Route — Destinations Tab

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to

7205551235 on line 25 are routed to extension 243.

W

a 257205551235 i X v | < =
Standard | Voice Recording Destinations
TimeProfile Destination Fallback Bxtension
» Default Value 243 Extn243 I~ [~
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Incoming Call Routes for other direct mappings of DID numbers to Avaya IP Office users listed
in Figure 1 are omitted here, but can be configured in the same fashion.

5.9. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

( o[

Save Configuration

IP Office Settings
Atlantic City

Configuration Reboot Mode
@ Merge

1 Immediate

1 When Free

1 Timed

Reboaot Time

09:25

Call Barring

ok || cancel || Hep
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6. Configure Avaya Session Border Controller for Enterprise

This section describes the configuration of the Avaya SBCE. It is assumed that the initial
installation of the Avaya SBCE has been completed including the assignment of a management
IP address. The management interface must be provisioned on a different subnet than either the
Avaya SBCE private or public network interfaces (e.g., Al and B1). If the management
interface has not been configured on a separate subnet, then contact your Avaya representative
for guidance in correcting the configuration.

On all screens described in this section, it is to be assumed that parameters are left at their default
values unless specified otherwise.

6.1. Access the Management Interface

Use a web browser to access the web interface by entering the URL https://<ip-addr>, where
<ip-addr> is the management IP address assigned during installation. The Avaya SBCE login
page will appear as shown below. Log in with appropriate credentials.

AVAYA =

Password:

SeSSion BD rder Co ntrol Ier Thiz system iz restricted =olely to authorized users for legitimate
= businesz purpozes only. The actual or attempted unauthorized access,
for Enterp rlse uze or modificationz of thiz system iz strictly prohibited. Unauthorized

uzers are =ubject to company dizciplinary procedurez and or criminal
and civil penalties under state, federal or other applicable domestic and
foreign laws.

The uze of thiz =system may be monitored and recorded for
administrative and security reasons. Anyene accessing this system
exprezsly consents to zuch monitoring and recording, and is advized
that if it reveals possible evidence of criminal activity, the evidence of
zuch activity may be provided to law enforcement officials.

All usgers must comply with all corporate instructions regarding the
protection of information assets.

@ 2011 - 2013 Avaya Inc. All rights reserved.
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After logging in, the Dashboard screen will appear as shown below. All configuration screens of
the Avaya SBCE are accessed by navigating the menu tree in the left pane.

Session Border Controller for Enterprise AVAYA
Dashboard Dashboard
Admimsiraten installed Devices
Backup/Restore System Time 03:26:23 PM EDT Refresh EMS
System Management
Vi 6.2.1.Q07 i
> Global Parameters ersien GFEiE
> Global Profiles Build Date Mon Dec 9 17:33:02 CST 2013
> SIP Cluster
. Domain Policies Alams (past 24 hours) Incidents (past 24 hours)
Maone found. Maone found.

> TLS Management

> Device Specific Settings T

Mo notes found.

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 31 of 60
SPOC 9/23/2014 ©2014 Avaya Inc. All Rights Reserved. TWTIPO9SBCE



6.2. Verify Network Configuration and Enable Interfaces

To view the network information provided during installation, navigate to System Management.
In the right pane, click View highlighted below.

Session Border Controller for Enterprise AVAYA

Dashboard
Administration
B

System Management

Devices | | Updates | | SSL VPN | | Licensing |

85 agement

> Global Parameters %ﬁ:ﬁuﬂf&? Manaln_:'j:;:-mr:-nt Version e

> Global Profiles .

- SIP Cluster }‘;’;ésst‘}‘cf?mgg.l 103210120 6.21.Q07 Commissioned Reboot Shutdown Restart Application Ecllt Delete

> Domain Policies

A System Information page will appear showing the information provided during installation.
The name of the device (vnj-sbce2) appears in the Appliance Name field. This name will be
referenced in other configuration screens. Interfaces Al and B1 represent the private and public
interfaces of the Avaya SBCE respectively. Each interface has multiple IP addresses assigned to
it. The IP addresses used for SIP Trunking and thus applicable to this Application Note are
highlighted below. Each of these interfaces must be enabled after installation.

r General Configuration Device Configuration
Appliance Name vnj-shce2 HA Mode Mo
Box Type SIP Two Bypass Mode No
Deployment Mode  Proxy

r Network Configuration

Public IP

Metmask Gateway Interface
10.32.1258.20 10.32.128.20 2552552550 10.32.1258.254 Al
192.168.96.233 192.168.96.233 255,255 255 224 192.168.96.254 B1
10.32.128.21 10.32.128.21 255 255 2550 10.32.128.254 Al
192.168.96.234 192.168.96.234 255 255 255 224 192.168.96.254 B1

r DNS Configuration

Management IP(s)
Primary DNS 10.32.128.200 P 10.32.101.20
Secondary DNS
DMS Location Dz
DNS Client IP 10.32.128.20
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To enable the interfaces, first navigate to Device Specific Settings = Network Management in
the left pane and select the device being managed in the center pane. In the right pane, click on

the Interface Configuration tab. Verify the Administrative Status is Enabled for both the Al
and B1 interfaces. If not, click Toggle to enable the interface.

Dashboard

Administration

Backup/Restore

System Management

> (Global Parameters

> Global Profiles

> SIP Cluster

> Domain Policies

> TLS Management

4 Device Specific Settings
Network
Management

Media Interface

~

Session Border Controller for Enterprise

Network Management: vnj-sbce2

Network Configuration | Interface Configuration

AVAYA

vnj-shce?

Administrative Status

Al Enabled
A2 Disabled

B1 Enabled

Toggle
Toggle

Toggle
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6.3. Signaling Interface

A signaling interface defines an IP address, protocols and listen ports that the Avaya SBCE can
use for signaling. Create a signaling interface for both the internal and external sides of the
Avaya SBCE.

To create a new interface, navigate to Device Specific Settings = Signaling Interface in the
left pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the
right pane, select Add. A pop-up window (not shown) will appear requesting the name of the
new interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, signaling interface Int_Sig_Intf was created for the Avaya SBCE
internal interface and signaling interface Ext_Sig_Intf was created for the Avaya SBCE external
interface. Each is highlighted below. When configuring the interfaces, configure the parameters
as follows:

e Set Name to a descriptive name.

e For the internal interface, set the Signaling IP to the IP address associated with the private
interface (Al) defined in Section 6.2. For the external interface, set the Signaling IP to the
IP address associated with the public interface (B1) defined in Section 6.2.

e In the UDP Port, TCP Port and TLS Port fields, enter the port the Avaya SBCE will listen
on for each transport protocol. For the internal interface, the Avaya SBCE was configured
to listen for UDP on port 5060. For the external interface, the Avaya SBCE was configured
to listen for UDP or TCP on port 5060. Since TW Telecom uses UDP on port 5060, it
would have been sufficient to simply configure the Avaya SBCE for UDP.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Interface: vnj-sbce?2
Administration
Backup/Restore . - -
System Management Signaling Interface
> Global Parameters vnj-sbce2 Add
> Global Profiles
Signaling IP
> SIP Cluster
> Domain Policies Int_Sig_Intf 10.32.128.20 5060 — MNane Edit Delete
> TLS Management Ext_Sig_Intf 192.168.96.233 5060 5060 - Mone Edit Delete
# Device Specffic Settings Int_Sig_Intf RW  10.32.128.21 5060 —  —  None Edit Delete
Metwork Management
) Ext_Sig_Intf RW  192.168.96.234 — 5061 AvayaSBCServer Edit Delete
Media Interface
Signaling Forking
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6.4. Media Interface

A media interface defines an IP address and port range for transmitting media. Create a media
interface for both the internal and external sides of the Avaya SBCE.

To create a new interface, navigate to Device Specific Settings = Media Interface in the left
pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the right
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, media interface Int_Media_Intf was created for the Avaya SBCE
internal interface and media interface Ext_Media_Intf was created for the Avaya SBCE external
interface. Each is highlighted below. When configuring the interfaces, configure the parameters
as follows:

e Set Name to a descriptive name.

e For the internal interface, set the Media IP to the IP address associated with the private
interface (A1) defined in Section 6.2. For the external interface, set the Media IP to the IP
address associated with the public interface (B1) defined in Section 6.2.

e Set Port Range to a range of ports acceptable to both the Avaya SBCE and the far-end. For
the compliance test, the default port range was used for both interfaces.

Session Border Controller for Enterprise AVAYA
Dashboard Media Interface: vnj-sbce2
Administration
Backup/Restaore
Media Interface

System Management
. Global P t vnj-shce?

obal Farameters Modifying or deleting an existing media interface will require an application restart before taking
> Global Profiles effect. Application restarts can be issued from System Management

> SIP Cluster
> Domain Policies

Media IP Port Range

» TLS Management

) ) ) Int_Media_Intf 10.32.128.20 35000 - 40000 Edit Delete
4 Device Specific Settings - -
Ext_Media_lntf 192.168.96.233 35000 - 40000 Edit Delete
Int_Media_Intf_RW 10.32.128.21 35000 - 40000 Edit Delate
Signaling Interface Ext_Media_Intf RW 192.168.96.234 35000 - 40000 Edit Delete
Signaling Forking
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6.5. Server Interworking

A server interworking profile defines a set of parameters that aid in interworking between the
Avaya SBCE and a connected server. Create a server interworking profile for Avaya IP Office
and the service provider SIP server. These profiles will be applied to the appropriate server in
Section 6.7.1 and 6.7.2.

To create a new profile, navigate to Global Profiles = Server Interworking in the left pane. In
the center pane, select Add. A pop-up window (not shown) will appear requesting the name of
the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. Alternatively, a new
profile may be created by selecting an existing profile in the center pane and clicking the Clone
button in the right pane. This will create a copy of the selected profile which can then be edited
as needed. To view the settings of an existing profile, select the profile from the center pane.
The settings will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: IPOffice
Administration Add | Rename || Clane || Delete |
Backup/Restore .
System Management Profiles
> (Global Parameters cs2100 General || Timers || URI Manipulation | | Header Manipulation || Advanced |
# Global Profles avaya-ru A
Domain DoS 0CS-Edge-S Hold Support NONE
Fingerprint )
Server Interworking cisco-com 180 Handiing None
Phone Interworking cups 181 Handiing None
Media Farking OCS_FrontEn. .. 182 Handling Mone
Routing IPOffice 183 Handling None
Server Configuration ——— x
efer nandling o
Topology Hiding IPOffice-T38
Signaling Manipulation SP-General URI Group None
URI Groups SP-General-T... 3xx Handing 0
> SIP Cluster Diversion Header Support No
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6.5.1. Server Interworking — Avaya IP Office

For the compliance test, server interworking profile IPOffice was created for Avaya IP Office by
creating a new profile and accepting the default values for all settings. In particular, the T.38
Support parameter is set to No. The General tab parameters are shown below.

General H Timers H URI Manipulation ‘ | Header Manipulation H Advanced |
A
Held Support NONE
180 Handling None
181 Handling None
182 Handling None
183 Handling None
Refer Handling No
URI Group MNone
3xx Handling No
Diversion Header Support No
Delayed SDP Handling No
Re-Invite Handling No
T.38 Support No
URI Scheme SIP
Via Header Format RFC3261 W

Scroll down to see the rest of the General tab.

Privacy Enabled Mo
User Name
P-Asserted-ldentity No
P-Preferred-ldentity No

Privacy Header

DTMF
DTMF Support Naone

Edit

<

The Timers, URI Manipulation, Header Manipulation tabs have no entries.
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The Advanced tab parameters are shown below.

General ‘ ‘ Timers ‘ ‘ URI Manipulation ‘ ‘ Header Manipulation Advanced

Record Routes Both
Topology Hiding: Change Call-D Yes
Call-Info NAT Mo

Change Max Forwards Yes

Include End Point IP for Context Lookup Mo

0OCS Extensions Mo
AVAYA Extensions Mo
MNORTEL Extensions Mo
Diversion Manipulation Mo
Metaswitch Extensions Mo
Reset on Talk Spurt Mo

Reset SRTP Context on Session Refresh  No

Has Remote SBC Yes
Route Response on Via Port Mo
Cisco Extensions Mo

6.5.2. Server Interworking — TW Telecom

For the compliance test, server interworking profile SP-General was created for the TW
Telecom SIP server. When creating the profile, the default values were used for all parameters.
In particular, the T.38 Support parameter is set to No. Thus, the SP-General profile is identical
to the 1POffice profile created in Section 6.5.1.
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6.6. Signaling Manipulation

Signaling manipulation scripts provides for the manipulation of SIP messages which cannot be
done by other configuration within the Avaya SBCE. It was necessary to create a signaling
manipulation script that will be applied to the TW Telecom SIP server in Section 6.7.2. The
details of the script are shown in Section 6.6.1.

To create a script, navigate to Global Profiles = Signalling Manipulation in the left pane. In
the center pane, select Add. An edit window (not shown) will appear in which a title for the
script can be entered as well as the script itself. Once complete, click Save to save the new
script. Alternatively, a new script may be created by selecting an existing script in the center
pane and clicking the Clone button in the right pane. This will create a copy of the selected
script which can then be edited as needed. To view an existing script, select the script from the
center pane. The script will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Manipulation Scripts: Remove_Remote-Addr
Administration ‘ Download || Clone || Delete |
Backup/R
System Management Manipulation

Scripts

> (Global Parameters Signaling Manipulation ‘

Remove_Re...
4 Clobal Profiles = //Remove Remote Address header in outbound INVITE and 28@ OK
Domain DoS ProviderWith...
within session "ALL"
Fingerprint - ‘ {
Server Interworking act on message where ¥DIRECTION="OUTBOUND" and %ENTRY_POINT="POST_ROUTING"
Phone Interworking remove (¥HEADERS[ "Remote-Address"][1]);
Media Forking 3
Routing
Server Configuration
Topology Hiding
Signaling
Manipulation
URI Groups
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6.6.1. Signaling Manipulation Script — TW Telecom

A signaling manipulation script named Remove_Remote-Addr was created for TW Telecom
that removes the Remote Address header from all outbound messages from the Avaya SBCE to
TW Telecom. This header is removed because it is not used by the service provider and it
contains an internal enterprise IP address which should not be shared outside the enterprise.

Signaling Manipulation
//Remove Remote Address header in outbound INVITE and 282 OK
within session "ALL"™
! act on message where XDIRECTION="OUTBOUND" and XENTRY_POINT="POST_ROUTING"
¢ remove { ¥\HEADERS[ "Remote-Address"][1]);
h
b
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6.7. Server Configuration

A server configuration profile defines the attributes of the physical server. Create a server
configuration profile for Avaya IP Office and the service provider SIP server.

To create a new profile, navigate to Global Profiles = Server Configuration in the left pane.
In the center pane, select Add. A pop-up window (not shown) will appear requesting the name
of the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. To view the settings of
an existing profile, select the profile from the center pane. The settings will appear in the right
pane.

Session Border Controller for Enterprise AVAYA

Dashboard Server Configuration
Administration

Add

Backup/Restore

Server Profiles -
System Management . Use the add button to create a new Server Configuration profile.
> Global Parameters Mo entries

found.

4 Global Profiles

Domain DoS

Fingerprint

Server Interworking

Phone Interwarking

Media Forking

Routing

5

Topology Hiding
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6.7.1. Server Configuration — Avaya IP Office

For the compliance test, server configuration profile IPO-ACity was created for Avaya IP
Office. When creating the profile, configure the General tab parameters as follows:

e Set Server Type to Call Server.

e Set IP Addresses / FQDNSs to the IP address of the Avaya IP Office signaling interface.

e Set Supported Transports to the transport protocol(s) that can be used for SIP signaling by
Avaya IP Office.

e Set the UDP Port and TCP Port to the ports Avaya IP Office will listen on for SIP requests.
The standard SIP UDP/TCP port is 5060.

[ FHename H Clone H Delete ]

General || Authentication | ‘ Heartbeat | | Advanced |

Server Type Call Server
IP Addresses / FQDMNs 10.32.128.25
Supported Transports TCP, UDP
TCP Port 5060

LDP Port 5060

On the Advanced tab, set the Interworking Profile field to the interworking profile for Avaya
IP Office defined in Section 6.5.1.

‘ Rename || Clone || Delete ‘
General | ‘ Authentication || Heartbeat | ‘ Advanced ‘
Enable DoS Protection ]
Enable Grooming [l
Interworking Profile IPOffice
Signaling Manipulation Script Mone
TCP Connection Type SUBID
UDP Connection Type SUBID
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6.7.2. Server Configuration — TW Telecom
For the compliance test, server configuration profile TWTelecom was created for TW Telecom.
When creating the profile, configure the General tab parameters as follows:

e Set Server Type to Trunk Server.

e Set IP Addresses / FQDNSs to the IP address of the TW Telecom SIP server.

e Set Supported Transports to the transport protocol(s) that can be used for SIP signaling by
TW Telecom.

e Set the UDP Port to the port TW Telecom will listen on for SIP requests. The standard SIP
UDP port is 5060.

| Rename || Clone || Delete |

General ‘ | Authentication | ‘ Heartbeat H Advanced

Server Type Trunk Server
IP Addresses / FQDNs 192.165.100.54
Supported Transports UDP

UDP Port 5060

On the Advanced tab, set the Interworking Profile field to the interworking profile for TW
Telecom defined in Section 6.5.2. Set the Signaling Manipulation Script to the SIP
manipulation script created in Section 6.6.1.

| Hename || Clone || Delete |
General | | Authentication | | Heartbeat | | Advanced
Enable DoS Protection ]
Enable Grooming ]
Interworking Profile SP-General
Signaling Manipulation Script Remove Remote-Addr
UDP Connection Type SUBID
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6.8. Application Rules

An application rule defines the allowable SIP applications and associated parameters. An
application rule is one component of the larger endpoint policy group defined in Section 6.11.
For the compliance test, the predefined default-trunk application rule (shown below) was used

for both Avaya IP Office and the TW Telecom SIP server.

To view an existing rule, navigate to Domain Policies = Application Rules in the left pane. In
the center pane, select the rule (e.g., default-trunk) to be viewed.

Session Border Controller for Enterprise AVAYA
Dashboard Application Rules: default-trunk
Administration Add |Fi\terBy Device... V|
Backup/Restore —
System Management
> Global Parameters default
> Global Profiles . . .
. SIP Cluster default-trunk Out Maximum Concurrent Ma);i:ru;‘js;iiltcrna
4 Domain Policies Voice 2000 2000
Application Rules
Border Rules T o o
Media Rules I o O
Security Rules
Signaling Rules
Time of Day Rules CDR Support Mone
End Point Policy RTCP Keep-Alive No
Groups
Session Policies
> TLS Management
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6.9. Media Rules

A media rule defines the processing to be applied to the selected media. A media rule is one
component of the larger endpoint policy group defined in Section 6.11. For the compliance test,
the predefined default-low-med media rule (shown below) was used for both Avaya IP Office
and the TW Telecom SIP server.

To view an existing rule, navigate to Domain Policies = Media Rules in the left pane. In the
center pane, select the rule (e.g., default-low-med) to be viewed.

Each of the tabs of the default-low-med media rule containing data is shown below.

The Media NAT tab has no entries.

Session Border Controller for Enterprise AVAYA
Dashboard Media Rules: default-low-med

Administration |Filter By Davice... v
Backup/Restore

Media Rules It is not recommended to edit the defaults. Try cloning or adding a new rule instead.

System Management

default-low-med
> Global Parameters Media NAT ‘ | Media Encryption ‘ | Media Anomaly | | Media Silencing ‘ | Media QoS |
» Global Profiles default-low-med-enc
- SIP Cluster default-high Media NAT Learn Media IP dynamically
4 Domain Policies
i default-high-enc
Application Rules

Border Rules avaya-low-med-enc

The Media Encryption tab indicates that no encryption was used.

Media NAT | | Media Encryption | Media Anomaly | | Media Silencing | | Media QoS |

Audio Encryption
Preferred Formats RTP

Interworking

Preferred Formats RTP

Interworking

Capahility Megotiation O
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The Media Anomaly tab shows Media Anomaly Detection was disabled.

Media NAT | | Media Encryption | ‘ Media Anomaly | | Media Silencing | | Media QoS

Media Anomaly Detection [

The Media Silencing tab has no entries.

The Media QoS settings are shown below.

Media NAT | | Media Encryption | | Media Anomaly | | Media Silencing Media QoS
Media QoS Reporting
RTCP Enabled O
Media QoS Marking
Enabled
QoS Type DSCP
Audio QoS
Audio DSCP EF
Video Qo5
Video DSCP EF
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6.10. Signaling Rules

A signaling rule defines the processing to be applied to the selected signaling traffic. A signaling
rule is one component of the larger endpoint policy group defined in Section 6.11. For the
compliance test, the predefined default signaling rule (shown below) was used for both Avaya

IP Office and the TW Telecom SIP server.

To view an existing rule, navigate to Domain Policies = Signaling Rules in the left pane. In

the center pane, select the rule (e.g., default) to be viewed.

The General tab settings are shown below.

Session Border Controller for Enterprise

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> 3IP Cluster

4 Domain Policies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules
Time of Day Rules

End Point Policy
Groups

Session Policies
> TLS Management
> Device Specific Settings

Signaling Rules: default

Add |Fi|ter By Device V|

Signaling Rules

It is not recommended to edit the defaults. Try cloning or adding a new rule instead.

AVAYA

Clone

default

General”"1 ||" p

q

B Head: R Head, <i
F ] I

Qos | uciD |

No-Content-Typ.

Requests
Non-2XX Final Responses
Optional Request Headers

Optional Response Headers

Requests
Non-2XX Final Responses
Optional Request Headers

Optional Response Headers

Enable Content-Type Checks

Action Allow

Exception List

Allow
Allow
Allow
Allow

Allow
Allow
Allow

Allow

Content-Type Paolicy

Multipart Action Allow

Exception List

The Requests, Responses, Request Headers, Response Headers and UCID tabs have no
entries. The Signaling QoS tab is shown below.

General | ‘ Requests || Responses ‘ | Request Headers ‘ | Response Headers | Signaling QoS ‘ uciD ‘

Signaling QoS
QoS Type
DSCP

DSCP
AF41
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6.11. Endpoint Policy Groups

An endpoint policy group is a set of policies that will be applied to traffic between the Avaya
SBCE and an endpoint (i.e., a connected server). Thus, an endpoint policy group must be
created for Avaya IP Office and the service provider SIP server. The endpoint policy group is
applied to the traffic as part of the endpoint flow defined in Section 6.14.

To create a new group, navigate to Domain Policies = End Point Policy Groups in the left
pane. In the center pane, select Add. A pop-up window (not shown) will appear requesting the
name of the new group, followed by series of pop-up windows in which the group parameters
can be configured. Once complete, the settings are shown in the far right pane. To view the
settings of an existing group, select the group from the center pane. The settings will appear in
the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Policy Groups: default-low
Administration Add \ Filter By Device.. v ‘
Backup/Restore
Policy G 5 iz e ende: adit the de S. & instead.
System Management It is not recommended to edit the defaults. Try adding a new group instead
default-low
> Global Profiles default-low-enc
Policy Group
> SIP Cluster default-med
<« Domain Policies -S -Add
default-med-enc —
Application Rules ) Order  Application  Border Media Security  Signaling  Time of Day
Border Rules GRS defaultlow
-I default default 0 default-low  default default Edit  Clone
Media Rules default-high-enc -med
Security Rules

QCS-default-high
Signaling Rules

. -def-low-e...
Time of Day Rules avaya-cerione

End Point Policy
Groups

6.11.1. Endpoint Policy Group — Avaya IP Office

For the compliance test, endpoint policy group IPO-EP-Policy was created for Avaya IP Office.
Default values were used for each of the rules which comprise the group with the exception of
Application. For Application, enter the application rule referenced in Section 6.8. The details
of the default settings for Media and Signaling are showed in Section 6.9 and Section 6.10
respectively.

Policy Group

Summary ][ Add ]

Order  Application Border Media Security Signaling  Time of Day

default- default-low . e
trunk default -med default-low  default default Edit Clane
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6.11.2. Endpoint Policy Group — TW Telecom

For the compliance test, endpoint policy group SP-EP-Policy was created for the TW Telecom
SIP server. Default values were used for each of the rules which comprise the group with the
exception of Application. For Application, enter the application rule referenced in Section 6.8.
Thus, the SP-EP-Policy is identical to the IPO-EP-Policy created in Section 6.11.1.

6.12. Routing

A routing profile defines where traffic will be directed based on the contents of the URI. A
routing profile is applied only after the traffic has matched an endpoint server flow defined in
Section 6.14. Create a routing profile for Avaya IP Office and the service provider SIP server.

To create a new profile, navigate to Global Profiles 2 Routing in the left pane. In the center
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
profile, followed by series of pop-up windows in which the profile parameters can be configured.
Once complete, the settings are shown in the far right pane. To view the settings of an existing
profile, select the profile from the center pane. The settings will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Routing Profiles: default
Administration Add
Backup/Restore
Routing Profiles i i I i [
System Management It is not recommended to edit the defaults. Try cloning or adding a new profile instead.
» Global Parameters default Routing Profile
4 Global Profiles
_ Add

Domain DoS

Fingerprint Priority URI Group Next Hop Server 1 Next Hop Server 2

Server Interworking 1 * View Edit

Phone Interwarking

Media Forking

Routing

Server Configuration
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6.12.1. Routing — Avaya IP Office

For the compliance test, routing profile To-1PO-ACity was created for Avaya IP Office. When
creating the profile, configure the parameters as follows:

e Set the URI Group to the wild card * to match on any URI.

e Set the Next Hop Server 1 field to the IP address of Avaya IP Office signaling interface.
e Enable Next Hop Priority.

e Set the Outgoing Transport field to UDP. This is the transport protocol the Avaya SBCE
will use to send SIP messages to the Avaya IP Office.

View Routing Rule X

Priority 1
URI Group *
Mext Hop Server 1 10.32.128.25

MNext Hop Server 2

Mext Hop Priority
NAPTR Fi
SRV O
Mext Hop in Dialog ]
Ignore Route Header F
Outgoing Transport UDP
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6.12.2. Routing — TW Telecom

For the compliance test, routing profile To-TWTelecom was created for TW Telecom. When
creating the profile, configure the parameters as follows:

e Set the URI Group to the wild card * to match on any URI.
e Set the Next Hop Server 1 field to the IP address of the TW Telecom SIP server.
e Enable Next Hop Priority.

e Set the Outgoing Transport field to UDP as defined by TW Telecom. This is the transport
protocol the Avaya SBCE will use to send SIP messages to the TW Telecom.

View Routing Rule X

Priority 1
URI Group *
Mext Hop Server 1 192.168.100.54

Mext Hop Server 2 -

Next Hop Priority
NAPTR ]
SRV L
Mext Hop in Dialog ]
Ignore Route Header ]
Cutgoing Transport UbpP
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6.13. Topology Hiding

Topology hiding allows the host part of some SIP message headers to be modified in order to
prevent private network information from being propagated to the untrusted public network. It
can also be used as an interoperability tool to adapt the host portion of these same headers to
meet the requirements of the connected servers. The topology hiding profile is applied as part of
the endpoint flow in Section 6.14. For the compliance test, the predefined default topology
hiding profile (shown below) was used for Avaya IP Office and for the TW Telecom SIP server.

To add a new profile or view an existing profile, navigate to Global Profiles = Topology
Hiding in the left pane. In the center pane, select Add to add a new profile. In the center pane,
select an existing profile (e.g., default) to be viewed.

Session Border Controller for Enterprise AVAYA
Dashboard Topology Hiding Profiles: default
Administration Add
Backup/Restore
Topology Hiding z - = . )
> Global Parameters default Topology Hiding
4 Global Profiles
cisco_th_profile Header Criteria Replace Action Overwrite Value

Domain DoS - - ;

Fingerprit JC-FaxTH Referred-By IP/Domain Auto

Server Interworking JCVoiceTH Request-Line IP/Domain Auto

Phone Interworking To IP/Domain Auto

Media Forking SDP IP/Domain Auto

Routing Record-Route IP/Domain Auto

Server Configuration

g From IP/Domain Auto

Signaling Manipulation Via IP/Domain Auto

URI Groups Refer-To IP/Domain Auto
> SIP Cluster

Edit
» Domain Policies
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6.14. End Point Flows

Endpoint flows are used to determine the endpoints involved in a call in order to apply the
appropriate policies. When a packet arrives at the Avaya SBCE, the content of the packet (IP
addresses, URIs, etc) is used to determine which flow it matches. Once the flow is determined,
the flow points to policies and profiles which control processing, privileges, authentication,
routing, etc. Once routing is applied and the destination endpoint is determined, the policies for
the destination endpoint are applied. Thus, two flows are involved in every call: the source
endpoint flow and the destination endpoint flow. In the case of the compliance test, the signaling
endpoints are Avaya IP Office and the service provider SIP server.

To create a new flow for a server endpoint, navigate to Device Specific Settings = End Point
Flows in the left pane. In the center pane, select the Avaya SBCE device (vnj-shce2) to be
managed. In the right pane, select the Server Flows tab and click the Add button. A pop-up
window (not shown) will appear requesting the name of the new flow and the flow parameters.
Once complete, the settings are shown in the far right pane.

Session Border Controller for Enterprise AVAYA
Dashboard End Point Flows: vnj-sbce2

Administration

Backup/Restore

Subscriber Flows | Server Flows

vnj-shce2 Add

System Management

> Global Parameters

> Global Profiles
. SIP Cluster Use the add button to create a new Server Flow.

> Domain Policies

> TLS Management

4 Device Specific Settings
Metwork Management
Media Interface
Signaling Interface
Signaling Forking
End Point Flows

Session Flows
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6.14.1. End Point Flow — Avaya IP Office

For the compliance test, endpoint flow IPO-ACity was created for Avaya IP Office. All traffic
from Avaya IP Office will match this flow as the source flow and use the specified Routing
Profile To-TWTelecom to determine the destination server and corresponding destination flow.
The End Point Policy and Topology Hiding Profile will be applied as appropriate. When
creating the flow, configure the parameters as follows:

For the Flow Name, enter a descriptive name.

For Server Configuration, select the Avaya IP Office server created in Section 6.7.1.

To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the external signaling interface.

Set the Signaling Interface to the internal signaling interface.

Set the Media Interface to the internal media interface.

Set the End Point Policy Group to the endpoint policy group defined for Avaya IP

Office in Section 6.11.1.

e Set the Routing Profile to the routing profile defined in Section 6.12.2 used to direct
traffic to the TW Telecom SIP server.

e Setthe Topology Hiding Profile to the topology hiding profile defined for Avaya IP

Office in Section 6.13.

View Flow: IPO-ACity X

- Criteria - Profile
Flow Mame IPO-ACity Signaling Interface Int_Sig_Intf
Server Configuration IPO-ACity Media Interface Int_Media_Intf
URI Group * End Point Policy Group IPO-EP-Policy
Transport * Routing Profile To-TWTelecom
Remote Subnet * Topology Hiding Profile  default
Received Interface Ext Sig_Intf File Transfer Profile None
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6.14.2. End Point Flow — TW Telecom

For the compliance test, endpoint flow TW Telecom was created for the TW Telecom SIP
server. All traffic from TW Telecom will match this flow as the source flow and use the
specified Routing Profile To-IPO-ACity to determine the destination server and corresponding
destination flow. The End Point Policy and Topology Hiding Profile will be applied as
appropriate. When creating the flow, configure the parameters as follows:

For the Flow Name, enter a descriptive name.

For Server Configuration, select the TW Telecom SIP server created in Section 6.7.2.
To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the internal signaling interface.

Set the Signaling Interface to the external signaling interface.

Set the Media Interface to the external media interface.

Set the End Point Policy Group to the endpoint policy group defined for TW Telecom
in Section 6.11.2.

Set the Routing Profile to the routing profile defined in Section 6.12.1 used to direct
traffic to Avaya IP Office.

Set the Topology Hiding Profile to the topology hiding profile defined for TW Telecom
in Section 6.13.

View Flow: TWTelecom X

- Criteria - Profile
Flow Mame TWTelecom Signaling Interface Ext Sig_Intf
Server Configuration TWTelecom Media Interface Ext Media_ Intf
URI Group * End Point Policy Group  SP-EP-Policy
Transport * Routing Profile To-IPO-ACity
Remote Subnet * Topology Hiding Profile  default
Received Interface Int_Sig_Intf File Transfer Profile None
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7. TW Telecom Managed SIP Services Configuration

TW Telecom is responsible for the configuration of TW Telecom Managed SIP Services. The
customer will need to provide the IP address used to reach the Avaya IP Office at the enterprise.
In the case of the compliance test, this is the public IP address of the Avaya SBCE. TW
Telecom will provide the customer the necessary information to configure the Avaya IP Office
including:

e [P address of the TW Telecom enterprise SBC
e DID numbers

8. Verification Steps

This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

8.1. System Status

The System Status application is used to monitor and troubleshoot Avaya IP Office. Use the
System Status application to verify the state of the SIP trunk. System Status can be accessed
from Start = Programs -> IP Office = System Status.

The following screen shows an example Logon screen. Enter the Avaya IP Office IP address in

the Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.

I TAvaya 1P Office Syste )

AVAYA IP Office System Status

Help Exit About

Online | offiine

Logon

Control Unit IP Address: BlikcyR iRl

Services Base TCP Port: Elsf:[sE

LSS T o Administrator

Password:

[ Auto reconnect
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

Status  Utiization Summary Alarms

IP Office System Status

SIP Trunk Summary
Feer Domain Name: 10.32.128.20
Resolved Address: 10.32.128.20
Line Mumber: 25
Number of Administered Channels: 10
Number of Channels in Use: 0
Administered Compression: G711Mu, GT11A, G729 A, G7231
Silence Suppression: Off
Layer 4 Protocol: LUDP
SIP Trunk Channel Licenses: Unlimited . 0%
SIP Trunk Channel Licenses in Use: 0
SIP Device Features:

er Party  Directi... Round Re
Trip D... Jitter

1

2

3

4

5

[ Idle |11days... 2
Trace [ Trace Al H Pause H Ping ] Call Details [ Print... H Save As... ]

Select the Alarms tab and verify that no alarms are active on the SIP line.

Last Date Of Error

Status  Utilization Summary Alarms

Alarms for Line: 25 SIP 10.32.128.20

Occurrences Errar Description
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8.2. Monitor

The Monitor application can also be used to monitor and troubleshoot Avaya IP Office. Monitor
can be accessed from Start = Programs = IP Office = Monitor. The application allows the
monitored information to be customized. To customize, select Filters - Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring.

All Settings S

T1 | WPN | WA | SCN | Jade |
aTM | cal | DTE | ECorf | FrameRelay | GOD | H323 | Interface |
ISDM ] Keya’Lamp] Directary ] Media ] PPP ] R2 ] Houting] Services  SIP l System]

Ewents

W Sip |Standad « v STUN [~ SIP Dect
Packets
[~ SIF Reg/Opt Rx [ SIP Misc Rx
[~ SIP Rea/Opt Tx [~ SIP Misc Tx
[~ SIP Call Rx [~ Crmn Matify Rx
[~ SIPCall T [ Crn Matify Tx
v Sip R« IP Filker [nim.nnn.nnn. nnn)
¥ Sip T |

Default All ‘ Clear All | Tab Clear &l ‘ Tab Set Al | Cancel

T ‘ Load File | LoadPartiaIFiIe‘ SelectFiIe|

9. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office 9.0
with the Avaya Session Border Controller for Enterprise to TW Telecom Managed SIP Services.
TW Telecom Managed SIP Services is a SIP-based Voice over IP solution for customers ranging
from small businesses to large enterprises. It provides a flexible, cost-saving alternative to
traditional hardwired telephony trunks. TW Telecom Managed SIP Services passed compliance
testing. Please refer to Section 2.2 for any exceptions.
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10. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] IP Office 9.0.3 IP500/1P500 V2 Installation, Document Number 15-601042, Issue 29f, June
13, 2014.

[2] IP Office Release 9.0 Manager, Document Number 15-601011, Issue 9.0.3, May 8, 2014.

[3] Using System Status, Document Number 15-601758, Issue 09c, August 15, 2013.

[4] IP Office Release 9.0.3 Administering Voicemail Pro, Document Number 15-601063, Issue
9.0c, April 24, 2014.

[5] Using IP Office System Monitor, Document Number 15-601019, Issue 05e, February 5, 2014.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and
™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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